Tutorial (Beginner level).

Orthomosaic and DEM Generation with Agisoft PhotoScan Pro 1.3

(with Ground Control Points)

Overview

Agisoft PhotoScan Professional allows to generate georeferenced dense point clouds, textured polygonal
models, digital elevation models and orthomosaics from a set of overlapping images with the corresponding
referencing information. This tutorial describes the main processing steps of DEM/Orthomosaic generation
workflow for a set of images with the ground control points.

PhotoScan Preferences

Open PhotoScan Preferences dialog using corresponding command from the 7ools menu:

H PhotoScan Preferences

@ H PhotoScan Preferences @

General | GPU I Advanced | Metwork | Appearance |

| General | GPU | Advanced | Metwork I Appearance |

User Interface

Language: [English - ]
Default view: [Point Cloud ~ ]
Theme: [Classic - ]

[T High DPT mode

Miscellaneous

Stereoscopic Display
Mode: [Anaglyph -
Parallax: L0 D

Measurement units: [Metre

Use derived units
Check for updates on program startup
Write log to file:

GPU devices:
iGeForce GTX 980 Ti (22 Cores @ 1076 MHz, 6144 ... | CUDA

Note: GPU acceleration is supported for image matching and depth maps generation.
D:\PhotoScan_Pro_1.3.txt D Ao 9 9 pth maps g
Use CPU when performing GPU accelerated processing
i ok 1 caneel || ey | [ ok [ cancel |[ apply |

Set the following values for the parameters on the General tab:

[ PhotoScan Preferences @

Advanced Netwark Appearance

Project Files

Compression level: [ Ll
Keep depth maps
[ Store absolute image paths

Export / Impart

[] 5trip camera extensions during model expart

Load camera orientation angles from XMP meta data
Load camera location accuracy from XMP meta data

Miscelaneous

Enable VBO support

Enable performance optimization

Enable rich Python console

Attach markers to shape vertices on photos

[ Refine marker projections based on image content

[ Reset Al Settings ]

Stereo Mode: Anaglyph (use Hardware if your
graphic card supports Quad Buffered
Stereo)
Stereo Parallax: /.0
Write log to file: specify directory where Ag-
isoft PhotoScan log will be stored
(in case of contacting the software support team
it could be required)
Set the parameters in the GPU tab as following: Check on
any GPU devices detected by PhotoScan in the dialog.
Check on “Use CPU” option when less than two GPU are
used.
Set the following values for the parameters on the
Advanced tab:
Project compression level: 6

Keep depth maps: enabled
Store absolute image paths: disabled

[ COK. ][ Cancel ][ Apply

)

Check for updates on program startup: enabled

Enable VBO support: enabled




Add Photos

To add photos select Add Photos... command from the Workflow menu or click Add Photos button
located on Workspace toolbar.
In the Add Photos dialog browse the source folder and select files to be processed. Click Open button.

Load Camera Positions
At this step coordinate system for the future model is set using camera positions.

Note: If camera positions are unknown this step could be skipped. The align photos procedure,
however, will take more time in this case.

Open Reference pane using the corresponding command from the View menu.

Click [ Import button on the Reference pane toolbar and select the file containing camera positions
information in the Open dialog.

The easiest way is to load simple character-separated file (*.txt, *.csv) that contains x- and y-
coordinates and height for each camera position (camera orientation data, i.e. pitch, roll and yaw values,
could also be imported, but the data is not obligatory to reference the model).

In the Import CSV dialog indicate the delimiter according to the structure of the file and select the row
to start loading from. Note that # character indicates a commented line that is not counted while
numbering the rows. Indicate for the program what parameter is specified in each column through setting
correct column numbers in the Columns section of the dialog. Also it is recommended to specify valid
coordinate system in the corresponding field for the values used for camera centers data.

Check your settings in the sample data field in Import CSV dialog.

E Import CSV [ S|

Coordinate System

|wes 84 (EPsG::4326) v |

Rotation angles: IYaw, Pitch, Raoll A I

Delimiter Columns

_) Tab Label: 1 =[] Accuracy |¥] Rotation  [] Accuracy

) Semicolon

4k

Longitude: 2 8 ; Yaw: § = |9

@ Comma

4k

Latitude: 3 3 : Pitch: & = |2
) Space

Altitude: 4 = [8 : Roll: 7 =

w

1 Other:
[7] Enabled flag:

L

Combine consecutive delimiters

Startimportatrow: 1 |5

Label Longitude Latitude Altitude  Yaw Pitch  Roll

Fname lon lat H azim pitch  roll time

IMG_0083.JPG 3878168067 54898102 631.8068 177.6310762 01.09.72 -0.1972  May 05 05:38:41 2011
IMG_0084.)PG 3878174392 5489721078 6321584 1720332889 01.09.92 -2.7096  May 05 05:38:47 2011
IMG_0085.)PG 387819421 5489639484 6357408  167.6400869 010648 -01136  May 05 05:38:52 2011
IMG_0086.JPG 3878227293 5489552851 636198  164.9311835 01.05.32 -0.0076  May 0505:38:57 2011
IMG_0087.JPG 3878265655 5489470755 6346232 172676666 01.0448 01.03.84 May0505:3%:01 2011
IMG_0088.JPG 3878285546 5489382426  632.0844 1805663709 01.0592 01.02.44  May 0505:32:06 2011
IMG_0089.JPG 3878284079 5489301226 6306564 183.8578081 01.07.08 01.01.22 May0505:39:12 2011
IMG_0090.JPG 3878273445 5489210528 632,834 1834790056 01.07.12 06668 May 05 05:39:17 2011
IMG_0091.JPG 3878264004 5489121207 633.2048 175.013302 01.06.28 -3.6484  May 0505:3%:22 2011
IMG_0092.JPG 3878277624 5489031478 6317776  174.004961 01.0516 0038 May 05 05:39:27 2011

[ OK ][ Cancel I

Click OK button. The data will be loaded into the Reference pane.

= Import EXIF button located on the Reference pane can also be used to load camera positions
information if EXIF meta-data is available.



Then click on the ¥ Settings button in the Reference pane and in the Reference Settings dialog select
corresponding coordinate system from the list, if you have not selected it in the Import CSV dialog yet.
Set up Camera Accuracy in meters and degrees according to the measurement accuracy:

-
H Reference Settings

Coordinate System

|WGS 84 (EPSG::4325)

Rotation angles: Yaw, Pitch, Roll

Measurement accuracy Image coordinates accuracy

Camera accuracy (m):

Camera accuracy (deqg): 50

Marker accuracy {m): 0.005 Marker accuracy (pix): 0.1

Scale bar accuracy (m): 0,001 Tie point accuracy (pix): 1

Miscellaneous

Ground altitude (m):

;[ Cancel ]

Ground Altitude should be specified in case of very oblique shooting and define the average ground
altitude level above the ellipsoid in the selected coordinate system.

Click OK and camera positions will be marked in Model View using their geographic coordinates:
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If you do not see anything in the Model view, even though valid camera coordinates have been

imported, please check that Show Cameras button is pressed on the Toolbar. Then click Reset View button

also located on the Toolbar.



Check Camera Calibration

Open Tools Menu — Camera Calibration window.

By default PhotoScan estimates intrinsic camera parameters during the camera alignment and optimization
steps based on the Initial values derived from EXIF. In case pixel size and focal length (both in mm) are
missing in the image EXIF and therefore in the camera calibration window, they can be input manually prior
to the processing according to the data derived from the camera and lens specifications.

If precalibrated camera is used, it is possible to load calibration data in one of the supported formats using
Load button in the window. To prevent the precalibrated values from being adjusted by PhotoScan during
processing, it is necessary to check on Fix Calibration flag.

PhotoScan can process the images taken by different cameras in the same project. In this case in the left
frame of the Camera Calibration window multiple camera groups will appear, split by default according to
the image resolution, focal length and pixel size. Calibration groups may also be split manually if it is
necessary.

In case ultra-wide or fisheye angle lens is used, it is recommended to switch camera type from Frame
(default) to Fisheye value prior to processing.

Bomeomon oot

Canon EOS 500D (28 mm) | Comera type: [Frame d
415 images, 47523168 pix Pixel size (mm): 0.00476651 ¥ 0.00476651
Focal length {mm): 28
Initial | Adjusted | GPS/INS Offset |
Type: [Auto V] [ Fix calibration =
f:  5574.32
o 0 bl: 0
cy: 0 b2: 0
ki: 0 pl: 0O
k2: 0 p2: 0
k3: 0 p3: 0
kd: 0 pt 0O
Camera label Resclution  Cameramodel  Focal length  Date 8 time il
IMG_0083JPG 47523168 Canon EQ55000 28 2011:05:05 09:39... L4
IMG_0084.JPG 47523168 Canon EQ5 5000 28 2011:05:05 09:40...
IMG_0085.JPG 47523168 Canon EQ5 5000 28 2011:05:05 09:40...
IMG_0086.JPG 475253168 Canon EQ55000 28 2011:05:05 09:40...
IMG_0087JPG 47523168 Canon EQ5 5000 28 2011:05:05 09:40...
IMG_0088.JPG 47523168 Canon EQ5 5000 28 2011:05:05 09:40...
IMG_0082.JPG 47523168 Canon EQ5 5000 28 2011:05:05 09:40...
IMG_0090JPG 47523168 Canon EQS 500D 28 2011:05:05 09:40..,
IMG_0091.JPG 47523168 Canon EQ5 5000 28 2011:05:05 09:40... -

[ Ok, ] [ Cancel




Align Photos

At this stage PhotoScan finds matching points between overlapping images, estimates camera
position for each photo and builds sparse point cloud model.
Select Align Photos command from the Workflow menu.

Hammoe L

- ¥ General

Accuracy: [ngh

Generic preselection

Reference preselection

- ¥ Advanced

Key point limit: 40,000

Tie point limit: 4,000
Constrain features by mask
Adaptive camera model fitting

[ ok

Set the following recommended values for the parameters in the Align Photos dialog:

Accuracy: High (lower accuracy setting can be used to get rough camera positions in a

Pair preselection: Reference + Generic (in case camera positions are unknown — only

Adaptive camera model fitting: Enabled (to let PhotoScan distortion parameters estimation).

Click OK button to start photo alignment. In a short period of time (depends on the number of
images in the project and their resolution) you will get sparse point cloud model shown in the
Model view. Camera positions and orientations are indicated by blue rectangles in the view
window:

shorter time)

Generic preselection mode should be used)

Constrain features by mask: Disabled (Enabled in case any areas have been masked)
Key point limit: 40,000

Tie point limit: 4,000
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Place Markers

Markers are used to optimize camera positions and orientation data, which allows for better model
referencing results.

To generate accurately georeferenced orthomosaic at least 10 — 15 ground control points (GCPs)
should be distributed evenly within the area of interest.

To be able to follow guided marker placement approach (which would be faster and easier), you need
to reconstruct geometry first.

Bowven e

- ¥ General

Surface type: [Height field

Source data: [Sparse doud

Face count: [I—hgh {185,934)

r ¥ Advanced

Interpolation: [Enabled (default)

Point classes: Al Select. ..

Calculate vertex colors

I

Select Build Mesh comand from the Workflow menu and specify folloing parameters in the Build
Mesh dialog:

Click OK button.

Then, when geometry is built (it usually takes a few seconds to reconstruct mesh based on the sparse
point cloud), open a photo where a GCP is visible in Photo View by double-clicking on its icon on the
Photos pane. Zoom in to locate the GCP on the photo and place a marker in the corresponding point of
the image using [ Create Marker command from the photo context menu available on right-click on

the opened photo in the corresponding position:
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Select the marker on the Reference pane. Then filter images in Photos pane using [ Filter by
Markers option in the context menu available by right-clicking on the markers label in the Workspace
pane.
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Now you need to check the marker location on every related photo and refine its position if necessary
to provide maximum accuracy. Open each photo where the created marker is visible. Zoom in and drag
the marker to the correct location while holding left mouse button. Repeat the described step for every
GCP.



Input Marker Coordinates

Finally, import marker coordinates from a file. Click = Import button on the Reference pane toolbar
and select file containing GCP coordinates data in the Open dialog. The easiest way is to load simple
character-separated file (*.txt) that contain markers name, x-, y- coordinates and height.

In Import CSV dialog indicate the delimiter according to the structure of the file and select the row to
start loading from. Note that # character indicates a commented line that is not counted while numbering
the rows. Indicate for the program what parameter is specified in each column through setting correct
column numbers in the Columns section of the dialog.

Also it is recommended to specify valid coordinate system in the corresponding field for the values used
for camera center data.

Check your settings in the sample data field in Import CSV dialog:

B Import CSV 5
Coordinate System
| WGS 84 / UTM zone 37N (EPSG::32637) x|
Rotation angles: l‘faw, Pitch, Rall - I
Delimiter Columns
_) Tab Label: 1 [2] O] Acauracy [] Rotation [] Accuracy
e Easting: 2 = |8 = Yaw: (8 = |9
@ Comma - -
Morthing: 3 51 |8 | Pitch: |9 SE
) Space
Altitude: 4 51 |8 - Roll: |10 = |9
1 Other: = °
Combine consecutive delimiters [7] Enabled flag: |5
Startimportatrow: 1 |5
Label Easting Morthing Altitude i
10 486333.2 6081648.6 168.5
20 4867717 60&1809.6 156.5
30 487141.3 6082538.2 1198 E
50 4872549 60&1668.6 1226
i 487514.3 60815887 15249
70 4880584 6081573 173.2
a0 486202.2 60820007 162.4
100 486504.9 6082000.2 1539 -
[ oK ] I Cancel J

Click OK button. The data will be loaded into the Reference pane.

Optimize Camera Alignment
To achieve higher accuracy in calculating camera external and internal parameters and to correct
possible distortion (e.g. “bowl effect” and etc.), optimization procedure should be run. This step is
especially recommended if the ground control point coordinates are known almost precisely — within
several centimeters accuracy (marker based optimization procedure).
Click the %% Settings button in the Reference pane and in the Reference Settings dialog select
corresponding coordinate system from the list according to the GCP coordinates data.

Prior to optimization it is also possible to remove the points with the highest reprojection error values
using corresponding criterion in Edit Menu — Gradual Selection dialog.



Set the following values for the parameters in Measurement accuracy section and check that valid
coordinate system is selected that corresponds to the system that was used to survey GCPs:

H Reference Settings @

Coordinate System

| WGS 84 / UTM zone 37 (EPSG::32637) - |
Rotation angles: [Yaw, Pitch, Roll - ]
Measurement accuracy Image coordinates accuracy

Camera accuracy (m): 10

Camera accuracy (deqg): 50
Marker accuracy {m): 0.005 Marker accuracy (pix): 0.1

Scale bar accuracy (m): 0,001 Tie point accuracy (pix): 1

Miscellaneous

Ground altitude (m):

E Ok ;[ Cancel ]

Marker accuracy: 0.005 (specify value according to the measurement accuracy).
Scale bar accuracy: 0.001

Projection accuracy: 0./

Tie point accuracy: /

Click OK button.

On the Reference pane uncheck all photos and check on the markers to be used in optimization
procedure. The rest of the markers that are not taken into account can serve as validation points to
evaluate the optimization results. It is recommended since camera coordinates are usually measured with
considerably lower accuracy than GCPs, also it allows to exclude any possible outliers for camera
positions caused by the onboard GPS device failures.

Click #° Optimize button on the Reference pane toolbar.

H Optimize Camera Alignment ﬁ

General

Fit f Fitb1

Fit cx, cy Fitb2

Fit k1 Fitpl

Fit k2 Fitp2

Fit k3 [T Fitp3

[T Fitka [T Fitps

[ Fit rolling shutter

[ 0K l [ Cancel l

Select camera parameters you would like to optimize. Click OK button to start optimization process.
(For DJI drone cameras it is usually suggested to optimize the rolling shutter).



Set Bounding Box

Bounding Box is used to define the reconstruction area.

Bounding box is resizable and rotatable with the help of eia Resize Region and % Rotate Region
tools from the Toolbar.
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Important: The colored side of the bounding box indicates the plane that would be treated as ground
plane and has to be set under the model and parallel to the XY plane. This is important if mesh is to be
built in Height Field mode, which is reasonable for aerial data processing workflow.

Build Dense Point Cloud
Based on the estimated camera positions the program calculates depth information for each camera to
be combined into a single dense point cloud.
Select Build Dense Cloud command from the Workflow menu.

B Build Dense Cloud [

¥ General

Quality: [Medium - ]
¥ Advanced

Depth filtering: [.ﬁ.ggressi'ue - ]

Reuse depth maps

[ Ok ][ Cancel ]

Set the following recommended values for the parameters in the Build Dense Cloud dialog:

Quality: Medium (higher quality takes quite a long time and demands more
computational resources, lower quality can be used for fast processing)

Depth filtering: Aggressive (if the geometry of the scene to be reconstructed is complex with
numerous small details or untextured surfaces, like roofs, it is recommended to set
Mild depth filtering mode, for important features not to be sorted out)
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Points from the dense cloud can be removed with the help of selection tools and Delete/Crop

instruments located on the Toolbar.

Build Mesh (optional: can be skipped if polygonal model is not required as a final

result)

After dense point cloud has been reconstructed it is possible to generate polygonal mesh model based

on the dense cloud data.

Select Build Mesh command from the Workflow menu.

| Build Mesh

e

- ™ General
Surface type:

Source data:

Face count:

[Height field -

[Dense cloud - ]

[Medium (16,967,032) v

r ™ Advanced
Interpolation:
Point dasses: All

Calculate vertex colors

|Enabled (default) - |

[ o

][ Cancel ]

Set the following recommended values for the parameters in the Build Mesh dialog:

Surface type: Height Field

Source data: Dense cloud

Polygon count: Medium (maximum number of faces in the resulting model. The values
indicated next to High/Medium/Low preset labels are based on the number of points in

the dense cloud. Custom

reconstruction).
Interpolation: Enabled

values could be used for more detailed surface

Click OK button to start mesh reconstruction.
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Edit Geometry

Sometimes it is necessary to edit geometry before building texture atlas and exporting the model.

Unwanted faces could be removed from the model. Firstly, you need to indicate the faces to be
deleted using selection tools from the toolbar. Selected areas are highlighted with red color in the Model
View. Then, to remove the selection use Delete Selection button on the Toolbar (or Del key) or use Crop
Selection button on the Toolbar to remove all but selected faces.

If the overlap of the original images was not sufficient, it may be required to use Close Holes
command from the 7ools menu at geometry editing stage to produced holeless model. In Close Holes
dialog select the size of the largest hole to be closed (in percentage of the total model size).

r!ﬁ Close Holes !!!gi!ﬂ

Level:

Lo

0% 100%

o< J[ concel |

PhotoScan tends to produce 3D models with excessive geometry resolution. That's why it is
recommended to decimate mesh before exporting it to a different editing tool to avoid performance
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decrease of the external program.

To decimate 3D model select Decimate Mesh... command from the Tools menu. In the Decimate
Mesh dialog specify the target number of faces that should remain in the final model. For PDF export
task or web-viewer upload it is recommended to downsize the number of faces to 100,000 - 200,000.

H Decimate Mesh Iﬁ

Parameters

Source face count: |50,616,485

Target face count: 3,500,000

E oK ; I Cancel

Click OK button to start mesh decimation procedure.

Build Texture (optional; applicable only to polygonal models)

This step is not really needed in the orthomosaic export workflow, but it might be necessary to inspect
a textured model before exporting it or it might be helpful for precise marker placement.

Select Build Texture command from the Workflow menu.

B Build Texture =

¥ General

Mapping mode: lﬂrmuphnto - I
Blending mode: IMnsaic (default) - I
Texture sizefcount: 8192 x |1

* Advanced

[] Enable color correction

Enable hole filing

E QK H Cancel I

Set the following recommended values for the parameters in the Build Texture dialog:

Mapping mode: Orthophoto

Blending mode: Mosaic
Texture size/count: 8192 (width & height of the texture atlas in pixels)

Enable color correction: disabled (the feature is useful for processing of data sets with
extreme brightness variation, but for general case it could be left unchecked to save the
processing time)

Click OK button to start texture generation.



Build DEM

Digital elevation model can be generated based on the dense cloud or mesh model. Usually first
option is preferred, as it provides more accurate results (low-poly model, being used as a source
data, may result in inaccurate DEM) and allows for faster processing, since mesh generation step
can be skipped.

Select Build DEM command from the Workflow menu:

Type: () Planar Geographic

|wGs 84 / UTM zone 37 (EPSG::32637)

Parameters

Source data: ’Dense cloud

Interpolation: |[Enabled (defauit)

Point classes: All

Region

Setup boundaries: | 435022, 702 | - [489295.290 | x

lsoaos21.938 | - |eos4247.038 | ¥

Resolution (m): 0.158571

Total size (pix): 26513

o || cancel |

Coordinate system should be specified in accordance with the system used for the model referencing.
At the export stage it will be possible to project the results to a different geographical coordinate system.

After DEM generation process is finished, it is possible to open the reconstructed model in Ortho view
by double-clicking on the DEM label in the ¢ chunk's contents on the Workspace pane:
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Build Orthomosaic

Select Build Orthomosaic command from the Workflow menu:

H Build Orthomeosaic I&

¥ Projection

Type: (") Planar @ Geographic

WGS 84 / UTM zone 37 (EPSG::32637)

Parameters
Surface: [DEI"-"I - ]
Blending mode: [Musaic {default) - ]

["] Enable color correction

Enable hole filing

@ Pixel size {m): 0.0792539 X
Metres... 0.0792539 Y

(71 Max. dimension {pix): 4096

Region

[ setup boundaries: |435344.481

6081186.440 6083715.513 ¥

Total size (pix): 34288 ¥ 31911

i

&
[£5]
[9,]
h
=

L

Nl
wn
=

[ oK ][ Cancel ]

Select desired surface for orthomosaic generation process: mesh or DEM, and blending mode.

Pixel size will be suggested according to the average ground sampling resolution of the original
images. According to the surface size and the input pixel size the total size of the orthomosaic (in pixels)
will be calculated and shown in the bottom of the dialog box.

Generated orthomosaic can be reviewed in Ortho mode similar to the digital elevation model. It can
be opened in this view mode by double-clicking on the orthomosaic label in the Workspace pane.



Export Orthomosaic

Select Export Orthomosaic — Export JPEG/TIFF/PNG command from File menu.

H Export Orthomosaic I&
Coordinate System
| WGS 84  UTM zone 37 (EPSG::32637) x|
Raster
@ Pixel size (m): 0.05 ¥
Metres... 0.05 Y
() Max. dimension {pix): 4096
(] split in blocks {pix): 10000 x | 10000
Raster fransform: MNone
Background color: [White -
Region
[7] setup boundaries: 485336.225 - |488565.210 ¥
6081180,617 - |6083735.344 Y
Total size (pix): 54579 ¥ 51094
Write KML file [ wirite world file

[] write tile scheme

Compression

Image description: Created with Agisoft PhotoScan

TIFF compression: [LEW 7
JPEG quality: a0 =
[ wirite BigTIFF file Write alpha channel

E Export... ;[ Cancel ]

Set the following recommended values for the parameters in the Export Orthomosaic dialog:

Projection: Desired coordinate system

Pixel size: desired export resolution (please note that for WGS84 coordinate system units
should be specified in degrees. Use Metres button to specify the resolution in metres).

Split in blocks: 70000 x 10000 (if the exported area is large it is recommended to enable
Split in Blocks feature, since the memory consumption is rather high at exporting
stage)

Region: set the boundaries of the model's part that should be projected and presented as
orthomosaic. Also polygonal shapes drawn in the Ortho view and marked as
boundaries will be taken into account for the orthomosaic export.

TIFF compression and JPEG quality should be specified according to the job requirements.
BigTIFF format allows to overcome the TIFF file size limit for the large orthomosaics, but it
is not supported by some applications.

Click Export... button and then specify target file name and select type of the exported file
(e.g. GeoTIFF). Click Save button to start orthomosaic generation.



Export DEM

Select Export DEM — Export GeoTIFF/BIL/XYZ command from File menu.

Bl Export DEM S

Coordinate System
| WGS 84 / UTM zone 37 (EPSG::32637) -
Raster
@ Pixel size (m): 0.5 X
Metfres, .. 0.5 Y
1 Max. dimension (pix): 4096
[T split in blocks (pix): 3000 x |3000
Raster transform: [Nnne -
Mo-data value: -32767
Region
(7] Setup boundaries: 435092.702 - (489293.939 X
6080521.938 | - |6084245.131 | Y
Total size (pix): 402 X 746
Write KML file Write World file
Write tile scheme
Compression
Image description: Created with Agisoft PhotoScan
[ wirite BigTIFF file
E Export... ; [ Cancel ]

Set the following recommended values for the parameters in the Export DEM dialog:

Projection: Desired coordinate system

No-data value: value for not visible points; should be specified according to the requirements
of the post processing application.

Pixel size: desired export resolution

Split in blocks: /0000 x 10000 (if the exported area is large, it is recommended to enable
Split in blocks feature, since the memory consumption is rather high at exporting
stage)

Region: set the boundaries of the model's part that should be projected and presented as
DEM. Also polygonal shapes drawn in the Ortho view and marked as boundaries will
be taken into account for the DEM export.

Click Export... button and then specify target file name and select type of the exported file
(e.g. GeoTIFF). Click Save button to start DEM generation.



